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Your Next Computer Will Be Green 
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Obtained from APCUG with the author's 
permission for publication by APCUG member 
groups. 
 
With Europe leading the way, the computer 
industry is decidedly becoming "green." The 
Waste Electrical and Electronic Equipment 
(WEEE) and the Restriction of Hazardous 
Substances (ROHS) directives went into effect 
earlier this year. These two directives state that 
certain electrical and electronic equipment must 
cut down on hazardous materials such as lead, 
mercury, and cadmium. They also give 
customers the right to return their equipment 
free of charge. Companies have several years to 
fully implement these directives, but the leaders 
have already started to make changes. 
 
Dell, for example, is advertising Energy Smart 
workstations and notebooks that can reduce 
power consumption by as much as 78%. The 
Energy Smart configuration uses a default power 
setting that is designed to reduce consumption 
and energy costs right out of the box. In addition, 
the power supply, fan, and motherboard use 
significantly less energy to maintain cool 
internal temperatures. 
 
HP is using 80 Plus power supplies to lower 
energy bills and AMD technology that reduces 
heat output and PC power consumption. In 
addition, they have already introduced an HP 
recycling program where you can trade-in or 
donate the products. 
 
Government Initiatives  
 
Many U.S. government agencies have 
implemented standards and regulations to 
encourage green computing. The Environmental 
Protection Agency  launched an Energy Star 
program in 1992 and strengthened its 

requirements in 2006. In 2003 the California 
State Senate enacted the Electronic Waste 
Recycling Act and in 2007 President Bush issued 
Executive Order 13423 requiring all federal 
agencies to use the Electronic Products 
Environmental Assessment Tool when 
purchasing computer systems. In addition, a 
global consortium called The Green Grid was 
founded in 2007 by AMD, APC, Dell, HP, IBM, 
Intel, Microsoft, Rackable Systems, SprayCool, 
Sun and VMware. 
 
Another initiative formed by a group of Global-
minded IT executives, the Green Computing 
Impact Organization (GCIO), was created to be 
an active participant in transforming the IT 
community from an environmental liability to an 
Earth conscious example of responsibility. GCIO 
is a nonprofit organization that is based on 
environmental audit programs for consumers 
and small business homes with respect to 
general energy-efficiency programs (including 
lighting, heating, insulation, etc.). GCIO’s mission 
is to educate and assist enterprise technology 
users in the design of environmentally aware 
and responsible information system operations. 
They help consumers become more 
environmentally responsible by reducing energy 
consumption and electronic waste in an effort to 
protect the Earth. 
 
GCIO is sponsoring educational programs across 
the country and participating in a Green 
Computing Summit that will be held in 
Washington, DC on May 20th. The summit will 
address how public sector IT managers, 
procurement officials, and program managers 
public sector professionals can transform their 
IT and data center operations into more 
environmentally conscious yet efficient 
solutions. This conference will attract senior 
government IT professionals and their industry 
partners tasked with helping agencies become 
greener in the coming years. Attendees will 
represent federal, state and local governments,  

Green continues on page 14 
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The July 2008 main meetings will be     

West Side ............ Tuesday, July 15 
CollegeAmerica, 6533 N Black Canyon Hwy, Phoenix, room 2 

East Side ........ Wednesday, July 16 
University of Advancing Technologies 

2625 W Baseline Rd, Tempe  

(one block west of Fry’s Electronics) 

Fountain Hills ..... Thursday, July 17 
Fountain Hills Library, 12901 N La Montana Drive,  

Fountain Hills   

 

The topic for the main meetings this 

month is: 

Microsoft Mindshare Applications 

 

Steering Committee will meet 
before the Fountain Hills meeting 

this Month 

Phoenix PC Users GroupPhoenix PC Users Group  

Steering Committee 

President: Dean Botchuck 

Vice-President: David Yamamoto 

Secretary: Chuck Lewis 

Treasurer: Lo Hardman 

Also 

Members who are present at the 
meeting 

 

Staff Members 

Membership Coordinator: Chuck Lewis 

Asst Membership Coord:  

Fountain Hills Coordinator: Tj  

East Side Coordinator: TBD 

West Side Coordinator: Bill Aulepp 

Public Relations: Tj 

Newsletter Editor: Bruce Jacobs 

Assistant Editor: TBD 

Advertising Manager: TBD 

 

 

Contact Information 

 

Dean Botchuck  president@phoenixpcug.org  

David Yamamoto  vicepres@phoenixpcug.org  

Chuck Lewis  secretary@phoenixpcug.org  

Lo Hardman  treasurer@phoenixpcug.org  

Bruce Jacobs  editor@phoenixpcug.org 

Inside this Issue… 

Your Next Computer Will Be Green  .................................................  2 

My Vista ..............................................................................................   6 

Viewing the Bigger Picture  ...............................................................  7 

Moving On to Vista  ............................................................................. 8 

Painter 4 Essentials, a First Impression  .........................................  9 

Skype 4.0  ........................................................................................... 10 

E-Mailing Photographs  ...................................................... Last Page 

Check our Website at www.phoenixpcug.org 
to verify subject matter and time for  

ALL meetings! 
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July 2008 General Meeting Topic 
 

All Meeting locations: 

Bylaws changes Q & A 

Microsoft© Mindshare Applications 

 

Fountain Hills: Steering Committee 

 
Coming in August 

 
All Meeting locations: 

Not Yet Finalized  

See Our Website 

 

WWW.PhoenixPCUG.org 

 

 
General Meetings start with Questions and Answers at 6:30 PM.  This is followed 

by the general topic of the meeting.  The meetings finish by 9:00 PM 
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CALENDARCALENDAR   

Check our website for room and time information and to check 

for last minute changes 

 

July 2008  

Tuesday, July 15 West (Mindshare Applications) .............. CollegeAmerica 

Wednesday, July 16 East  (Mindshare Applications) ................................ UAT  

Thursday, July 17 Fountain Hills  (Steering Committee) ..................Library 

Thursday, July 17 Fountain Hills  (Mindshare Applications) ..........Library 

Wednesday, July 23  (Photo SIG) ............................................... CollegeAmerica 

Wednesday, July 23  (Video SIG) ............................................... CollegeAmerica 

 

August 2008  

Tuesday, August  19 West (TBD) ............................................... CollegeAmerica 

Wednesday, August 20 East  (TBD) .................................................................. UAT  

Thursday, August 21 Fountain Hills  (TBD) ............................................Library 

Wednesday, August 27  (Photo SIG)......................................... CollegeAmerica 

Wednesday, August  27  (Video SIG) ........................................ CollegeAmerica 

 Editors Note: 
Next month is the last month I will be doing the  

newsletter editing by myself. 
 

In September the new editor must be chosen or 
the newsletter will not be produced! 
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By Rob Limbaugh, President, Danbury Area Computer 

Society, CT 

www.dacs.org 

relimbaugh(at)dacs.org 

 

Obtained from APCUG with the author's 
permission for publication by APCUG member 
groups. 
 
Just about every year I make some sort of ‘major’ 
effort to move forward with technology in some 
way on my primary home workstation. I 
periodically wipe out the machine and start a 
fresh OS install from scratch. I reasoned that as 
laborious a reinstall is, I may as well bite the 
bullet and this time make the move to Vista. What 
made the timing right was that Microsoft gave 
Windows Vista Ultimate 32-bit w/SP2 for those 
who attended the APCUG 2008 LDC. Here’s my 
experience. 
 

Check Compatibility 
 
When loading an OS it is important to make note 
of your hardware and key software. Vista Update 
Advisor will highlight any hardware or software 
compatibility issues of which to be aware. In my 
case, the only issues to address were applications 
that would be replaced with new Vista versions—
no big deal. In terms of hardware, my machine 
checked out OK. Last I had heard, my ATI All-In-
Wonder 2006 video card was not yet supported 
in Vista, so I double checked the AMD (they now 
own ATI) website and confirmed there are now 
Vista drivers and software. It’s a Go! 
 

Backup Data 
 
Next, I made backups of all my important data. 
This time around I used an external USB hard 
drive and just dragged and dropped the data to a 
‘backup’ folder. I wanted to start fresh and clean, 
so I didn’t bother making a backup of my 
Windows or Office user settings. There aren’t any 

new BIOS updates for my motherboard, so I was 
all set to go. 
 

Time for Install 
 
I started the install process around 8 p.m., 
electing to wipe all partitions on the hard drive. 
My first boot to the desktop post install was 
shortly after 10 p.m. So far, so good. And, 
considering this is a P4 2.4GHz machine, I was 
rather impressed. Vista’s graphics worked from 
the get-go because the ATI All-In-Wonder 2006 
uses an ATI Radeon 9600 compatible chipset for 
which Vista loaded drivers. Sound worked. 
Networking worked. I expected SOMETHING to 
be wrong, due to all the horror stories I had 
heard! My machine even received a 3.2 on the 
“Vista Experience Index”. That means I can use 
Aero! Now we’re cooking! 
 

Post Install Issues 
 
A notice appeared that Windows detected 
hardware and needed to install drivers. My 
system’s motherboard has an integrated Realtek 
AC’97 sound card. Unfortunately there isn’t a 
Vista driver for the MIDI interface. If I want to 
hook up MIDI devices in the future, I will 
probably need to disable the built-in sound card 
and install a properly supported one to gain MIDI 
interface functionality. 
 
Watching TV is one of the things for which I built 

this machine, and I expected to use Vista Media 

Center. This is where my second issue came up. 

While AMD (they bought ATI) has released 

updated Vista drivers and software for the ATI 

AIW 2006 video card, they didn’t actually ‘fix’ the 

issue with how the ATI Hydravision software 

accesses the TV Tuner. I searched around for a 

solution and came across a Home Theater 

application called “Beyond TV” by SnapStream. So 

My Vista continues on page 13 

My Vista 
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By Bonnie L. Snyder,  

P*PCompAS, Colorado Springs, CO 

http://ppcompas.apcug.org/ 

Bonniels21(at)gmail.com 

 
Obtained from APCUG with the author's 
permission for publication by APCUG member 
groups. 
 
At the risk of being the bearer of bad news, I have 
to say that none of us is getting any younger. User 
groups tend to be populated more by senior 
citizens than by any other age group. As we age, 
we find the need for more and more assistive 
aids, including those that will help us to use our 
computers more comfortably and efficiently. 
 
Many of us will find, as time goes on, that our 
vision is not what it used to be. We may find that 
our eyes fatigue as we read information on the 
computer monitor, and we may find that some of 
the smaller fonts and graphics on the screen 
require us to squint and lean forward into the 
display. 
 
In this article, I will discuss two screen 
enlargement programs that might help us 
minimize our visual difficulties as we use our 
computers.  
 
The first program I want to talk about is called 
Magic Lens Max. I downloaded an older version 
of the program from Giveawayoftheday.com and 
was very impressed with what it could do. I e-
mailed the program’s author and told him what a 
terrific program it was and I have demonstrated 
it to various groups who provide services to the 
blind and visually impaired. Additionally, the cost 
of the program is only $39.95. I went ahead and 
purchased a copy of the most recent edition and 
was even more pleased with what the author had 
added since my downloaded version. 
 
Magic Lens Max provides a variety of ways to 
magnify the computer screen, from resizable 

moveable lenses, which magnify directly over 
where your mouse or cursor is working, to a full 
screen magnification option, which slows down 
the screen refresh very minimally. You have 
some color contrast options to choose from with 
this program as well as an invert colors option 
for light text on dark background. The 
magnification levels can be selected from 50% 
(which is non-magnification) up to pretty much 
infinity. Anything above 350% starts to blur a bit, 
although there are options to sharpen. Below is 
the Magic Lens Max option screen: <insert 
magic_lens_max> 
 
The Magic Lens Max icon that resides in the 
system tray can be single-clicked to turn on or 
turn off the magnification. 
 
This is an excellent program that is both useful 
and affordable. If you are interested in testing it 
out, go to www.visionsuit.com. You can 
download a 30-day demo of the latest version. If 
you decide to purchase Magic Lens Max, once you 
have paid the $39.95, you will be sent a 
registration code that can be entered into the 
demo, and it becomes fully functional. 
 
The second program I evaluated for screen 
magnification allows for an additional option: 
speech along with the magnification. This 
program is called iZoom, and can be obtained 
from http://www.issist.com/. I really like the 
customizing options available in iZoom. These 
can be accessed from the initial menu when 
iZoom comes on, or once the menu is closed, you 
can reopen it quickly by clicking the mouse on 
the iZoom icon in the system tray. Here are the 
option screens: <insert izoom1 and izoom2> 
 
iZoom allows for default or customizable hot 
keys, several sizes and colors of mouse pointers, 
color combinations supplied with the program, 
as well as custom color modes, several sizes and 

Viewing continues on page 15 
 

Viewing the Bigger Picture 
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Moving on to Vista  
By Neil Stahfest, Librarian, Tacoma Area PC User 

Group, WA 

www.tapcug.org 

ncstahfest(at)msn.com 

 
Obtained from APCUG with the author's 
permission for publication by APCUG member 
groups. 
 
Windows Vista is becoming more popular every 
day, but there are still several special features 
that few people are aware of! Besides the energy 
saving features I mentioned last month, there's 
another feature that goes largely unnoticed by 
the average user. It's about displaying time in 
multiple time zones using Vista's system clock. It 
works very well, particularly since we work with 
countries all around the world and are no longer 
confined to one time zone. It also helps when you 
intend to chat with a friend or family member 
who lives in another part of the country. Now, 
instead of calculating different time zones in your 
head, you can have a handy toolbar on your Vista 
computer that will tell the time for you.  
 
1. The first step is to right click on the clock in 
your system tray at the bottom of  
your desktop.  
2. Select Adjust Date/Time.  
3. Click on the Additional Clocks tab at the top of 
the window.  
4. Choose the checkbox that you want to show 
the additional clock.  
5. Next, pick a time zone and give it a title.  
6. You can add up to two additional time zones 
this way.  
7. Apply your changes.  
 
To see the additional times, just hover your 
mouse over the clock in the system tray.  
 
Vista's Service Pack 1 is out, if you have 
automatic updates enabled on your PC its should 
already be installed. So what does SP1 do? 
Microsoft previously announced that Service 
Pack 1 would improve the operating system's 
performance and security. It would speed up file 

copying, waking up from sleep and hibernation 
faster and add and extract files from compressed 
folders faster.  
 
When you install SP1 it apparently checks to see 
if you have installed previous updates and if it 
doesn't find them it installs them. Then in 
proceeds to install it's ―new ― features. I had 
used automatic updates to keep my installation 
current and Service Pack 1 installed quickly on 
my laptop without any apparent problems.  
 
Did I see any improvements? <sigh> Not really. I 
saw no noticeable improvements in performance. 
As far as I could tell start-up time was the same 
and file copying was the same but the file copy 
―fix‖ I had previously. Other people have 
reported similar impressions. One person 
reported Vista with SP1 compressed files faster 
than without SP1 but it is still slower than 
Windows XP.  
 
What about new features? Frankly, the only one I 
looked for and found was the disk defragmenter. 
Pre SP1 when you selected the defrag function 
you had no choices. The function simply 
defragmented your all of your hard drive. With 
SP1 installed, the defragmenter first examines 
your computer and makes a suggestion as to 
whether your drives and partitions need to be 
defragemented. There's also an option to 
schedule defragmenting at regular time intervals. 
I don't remember if this was available pre-SP1.  
If you select the button to defrag your hard drive, 
you see a new screen which gives you the 
alternatives to defrag all of your partitions and 
drives or select specific partitions and hard 
drives to be defragmented. As with pre-SP1 Vista, 
you can defrag your hard drive(s) while 
continuing to use your computer. There is no 
specific information that tells you how badly 
fragmented your drives are or how much space is 
used. In my opinion, the disk defragmenter in 
Windows XP was more useful. For that kind of 
detail you'll need to use a third party disk 
defragmenter. I would say that Vista's  

Moving On continues on page 15 
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Painter 4 Essentials, a First Impression 
By Dave Chalmers,  

Editor, Kern Independent PCUG, CA 

www.kipug.org 

newsletter(at)kipug.org 

  
Obtained from APCUG with the author's 
permission for publication by APCUG member 
groups. 
 
Corel’s demonstration of their products at the 
recent Southwest Computer Conference showed 
one new product that really interested me. Corel 
Painter 4 Essentials is a real painting program, 
not a photo editing program. It has the features of 
being able to paint or draw with a computer. If 
you have a shred of drawing talent, you might 
really like this program. 
 
Now I have no talents this way unfortunately. 
Why I would buy a program like this, being a 
photographer, might surprise you. Painter has a 
great feature that will auto paint or draw from a 
photo. In this mode you pick a style from many 
artistic techniques and stand back. 
 
Will this look great for all photos? The simple 
answer is no. If you have a lousy picture you will 
probably end up with a lousy painting. Photos 
that are dependent on a lot of fine detail to work 
will also not be a good candidate for this product. 
Simple landscapes or portraits or more abstract 
photos will probably work the best. Now having 
said that, there are always exceptions that will 
work, trying the process only takes some time. 
You start with a photo that has been corrected 
and cropped using a photo editing program. 
Jpeg’s, tiff, and PhotoShop psd files will work. Just 
open them in Painter and start selecting the 
artistic medium you want. Once the program 
commences you will see a very blobby and 
abstract image in the beginning. As the process 
continues, details emerge; you can stop the 
drawing at any time or let it go to completion. 
Once done you can go into using your own 

painting efforts to add or subtract details to 
enhance the painting. A good example of this 
would be a portrait. Increasing the details around 
the eyes usually helps the overall composition. If 
some of the background contrasts too much with 
the person, you can blur and tone down the 
background. 
 
A graphic tablet is a real plus with Painter, as it 
uses the stylus for changing the brush 
characteristics, as you go. A mouse works fine, but 
it doesn’t have as much flexibility as the tablet. 
Wacom makes some tablets that are fairly 
inexpensive. Please note, a tablet is not required 
to get this program to work. 
 
Printing with this program is quite simple. It 
doesn’t have a dedicated color management 
system as more expensive programs, but if you 
can print a good photo, then printing with Painter 
is no problem. 
 

Painter comes with some excellent video tutorials 
that really clue you in on the features and give a 
great how-to aspect to it. They are logically 
arranged and each segment is not too long. 
Painter even comes with a nice printed manual, 
with illustrations. The manual generally follows 
along with the tutorials. 
 

Retail price is $99 and the member price is $79. It 
installs on both PC’s and MAC’s. As a supplement 
to a photo editing program, I certainly 
recommend it. 
 

This article has been provided to APCUG by the 
author solely for publication by APCUG member 
groups. All other uses require the permission of 
the author (see e-mail address above). 
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http://ppcompas.apcug.org/ 

nuvo(at)nuvolini.com 

 

Obtained from APCUG with the author's 
permission for publication by APCUG member 
groups. 

 
I've been a Skype subscriber for some time now. 
What is Skype, you say? Well, it's an online chat/
phone/video service which has, as of the end of 
March, some 309 million registered users. Last I 
heard, that is more subscribers than all the US 
telephone services combined! It allows you to 
make computer to computer calls free worldwide. 
It can support 12 million users at a time. In 
addition to audio and video chat, you can instant 
message, send text messages to phones, and share 
files. You can call from computer to phone as well. 

It has three levels of service for the computer to 
phone service. For $2.95 per month you can make 
free computer to phone calls anywhere in the US 
and Canada. The $5.95 service includes the US, 
Canada, and Mexico City, Guadalajara, and 
Monterrey Mexico. For $9.95 per month you get 
unlimited free computer to phone calls worldwide.  
They point out that unlimited means up to 10,000 
minutes per month. Let's see, 10,000 minutes is 
over 6.9 days! I'm currently subscribing to the 
$2.95 service. To call overseas with my service it 
runs about 2.1 cents per minute to Europe or from 
Europe back to the States. Skype has been offering 
video calling as well since 2005. Their data 
compression allows quality voice transmissions on 
a bandwidth of as little as 2kbs and video on 6kbs. 
It has a new version, 4.0, which is in beta testing. It 
allows you to see the person you are calling full 
screen. For this feature to work well you need 
90kbs. I'm using it and it seems to work real well. 
This full screen mode will be very useful for the 
computer user group community. 

While at the Association of PC User Groups 
(APCUG) Convention held in conjunction with the 
January 2008 Consumer Electronics Show (CES) 
attendees in their forum with the vendors 

discussed presentations at user group meetings. 
Over the years, the cost of sending representatives 
out to user groups for the purpose of promoting 
their wares has become no longer cost effective. 
We discussed the use of Webinars (live 
presentations across the Internet). 

This new version of Skype looks to be ideal for 
such a program and it can be done at little or no 
cost to the vendors and user groups. If you haven't 
tried Skype, you should. You can download the 
current version (3.8) at: http://www.skype.com/
download/skype/windows/. If you are 
adventurous and want to try 4.0 beta go to: http://
www.skype.com/intl/en/download/skype/
windows/bets/. 

By the way, if you have wireless Internet access 
you can purchase a WiFi phone at the Skype online 
store and it will allow you to make calls whenever 
and wherever you have wireless Internet access. 
There's a lot more information which you can 
checkout at their Website: http://www.skype.com. 

 

This article has been provided to APCUG by the 
author solely for publication by APCUG member 
groups. All other uses require the permission of 
the author (see e-mail address above). 

New Editor Needed for Newsletter 
 

No experience needed 

 

Come September I will have been editing and 

publishing the Phoenix User Group News for 

two years.  As I am no longer able to at-

tend meetings and do not have time to prop-

erly produce the newsletter, much less time 

to write articles, I have decided it is 

time to pass on the torch in September.   

 

It is not really that difficult, it just 

takes some time. 

 

I am willing to give the new editor lots of 

training and other help.  Please contact 

the board or myself if you have any ques-

tions   

 

Bruce Jacobs   jacobsbd@cox.net 

Skype 4.0 

http://www.skype.com/
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Photographs continues from last page  

Computer and choose Resize Pictures. You are  
limited to four specific sizes but they are good 
choices. They don’t tell us what compression they 
are using but the results look OK. Unless you tell 
them under Advanced to replace the image in the 
file, it will make a copy. That’s good. They will add 
the word, “Large”, “Medium” or “Small” to the end 
of the name you have chosen. 
 
If you are happy with this solution, then read no 
further. But, if you want to use a picture editing 
program, maybe this will help. 
 
In Photoshop Elements 5, click on 
Image>Resize>Image Size and this window will 
pop up. Note that there is some garbage at the 
bottom about “inches” but we will ignore that. 
First we will click the Resample Image box. That 
puts the Pixel Dimensions in play and that is what 
we want. I selected the Width box and changed the 
width to 800 pixels. Since the Constrain 
Proportions box is selected, that is all I have to do.   
 

 

Note, down at the bottom, that we have several 
choices of sampling algorithms. This is frosting on 
the cake. I read somewhere that I should use 
Bicubic Sharper when downsizing so that is what I 
do. Most programs don’t give us all these choices. 

Then we should click on File>Save As and give the 
photo a new name. I often just use the same name 
and add “_800px” so the next time I will know it is 
ready to e-mail. Here we can choose the JPEG 
format and the compression amount. Photoshop 
Elements 6 is out now and sells for about $100. If 
you are able to spend that much and want one of 
the best editing programs, I highly recommend it. 

 
Let’s look at Picasa2. It is a free program from 
Google and looks really good but I do not have 
much experience with it. By all means, try it first 
because the price is right! When it comes to e-
mailing photographs, it is a little more automated 
but not any easier to use than Elements. First, click 
on Tools>Options>E-Mail. Then select the width 
you want in pixels. There are six choices. Then 
click on Apply and OK.  
 

Photographs continues on page 12 
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Photographs continues from page 11 

The next step is to click on File>E-Mail and you 
will get three choices of how you want to e-mail 
your photos. Fortunately, I use Outlook Express so 
my choice is listed. 
 

When I clicked on Outlook Express, an e-mail page 
popped up with the photo attached. At this point 
we can write something else on the e-mail and 
send it. I recommend this so the recipient will 
know it is really from you and not something sent 
out by a virus. When I receive e-mails that only say 
“Attached”, I Delete them without looking at the 
attachment. This saved me one time when I 
received a virus from my sister-in-law that she did 
not know she sent. She spent weeks and dollars 
getting her computer back up. Oh, I digress. If you 
want to send more than one picture (and, who 
doesn’t?), you must select the picture and click on 
the Hold button near the bottom of the screen. Do 
this for each photo you want to send and they will 
all be attached to the e-mail. The program 
automatically chooses JPEG format and a 

compression ratio but does not tell you. That is OK 
as the pictures I tried looked good. Picasa2 has 
considerable capability for editing photos in many 
respects. Try it! 

 
There are many other editing programs that I 
haven’t mentioned and have no experience with. 
In all cases you want to change the picture’s size in 
pixels by resizing or resampling. Pay no attention 
to anything that says “inches” as that will have no 
meaning for this process. Sometime later we will 
talk about printing pictures and then we will use 
inches. 
 
This article has been provided to APCUG by the 
author solely for publication by APCUG member 
groups. All other uses require the permission of 
the author (see e-mail address above). 

Want your own 15  
minutes of fame? 

Write an article for your  
newsletter. 

 
 Explain Something 
 Review a Product 
 Write a letter to the Editor 
 Solve World Hunger! 
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My Vista continues from page 6 

 

Obtained far that seems to solve my issue. 

Beyond TV has a ton of cool features (worth 

looking at even if you aren’t going to Vista). 

 

Reality Check 
 

In my consumer opinion, lack of proper drivers 

for an OS is the fault of the hardware integrator 

and not the OS maker. AMD is blaming 

Microsoft’s changes in DirectX 10 D3D (which 

happen to address performance and security) as 

why the ATI TV Tuner software doesn’t work. 

Well, AMD, how come SnapStream could figure it 

out? AOpen has not released any new drivers for 

their implementation of the AC’97 chip on my 

motherboard. I can live with AOpen’s choice 

because most people don’t use the MIDI interface 

feature of sound cards. AMD has no excuse for 

not supporting an expensive video card that is 

bought for the very feature they aren’t 

supporting. My buying habits will be adjusted 

accordingly in the future. 

 

Supporting Apps 
 

Along with Beyond TV, I installed what I 

consider ‘Base Supporting Apps’. These included 

Avast! Antivirus, Notepad++, Pidgin, Adobe 

Reader, Adobe Flash Player, 

Adobe Shockwave Player, TrueCrypt, PrimoPDF, 

and WinSCP. Office Ultimate 

2007 is going to round out the Office Suite. 

Everything installed smoothly. No issues, 

arguments, or contentions between apps. 

 

Where I Stand 
 

My machine has paid its dues many times over 

and the driver issues didn’t affect my ability to 

use what I needed, so I was OK with that. Others 

with more particular needs should be aware that 

integrated soundcards, atypical hardware, old 

devices, and fancy graphics capture cards may 

require special attention. Replacements may 

need to be considered. I’m not suggesting 

everyone run out and install Vista. This is now 

the fourth time I’ve installed Vista on a 

machine—first time on one I plan to use 

regularly. All said and done, the experience has 

been pleasant and not anything like the horror 

stories I’ve heard. At the time of this writing it’s 

been about two weeks and all continues 

to work well. This article was typed on that 

system using Word 2007 and sent 

to the editors with Outlook 2007. 

 

From my vista, Vista works just fine. 

 

Vista Upgrade Advisor: 

http://www.microsoft.com/windows/p r o d u c 

t s / w i n d o w s v i s t a /buyorupgrade/

upgradeadvisor.mspx 

Compare Vista Editions: 

http://www.microsoft.com/windows/products/

windowsvista/editions/choose.mspx 

SnapStream Beyond TV: 

http://www.snapstream.com/products/

beyondtv/ 

 

This article has been provided to APCUG by the 

author solely for publication by APCUG member 

groups. All other uses require the permission of 

the author (see e-mail address above). 
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Green continues from page 2 

public policy organizations and suppliers to 
government. You can read more about this event 
at www.e-gov.com/EventOverview.aspx?
Event=SGCS08 . 
 

Features of Green Computing 
 
Power management is the most popular method. 
The operating system of the computer can be set 
to directly control the power saving aspects of the 
hardware. It can automatically turn off the 
monitor or hard drive after a period of inactivity. 
Or, the entire system may hibernate, turning off 
most of the components such as even allow the 
user to manually adjust the voltages supplied to 
the CPU to reduce the electricity consumption and 
the amount of heat that is produced. As of July of 
2007, all new Energy Star certified desktops must 
have a power supply that is at least 80% efficient. 
Other features include using motherboard video 
output instead of a video card, hard disks that 
consume less power, flash based solid state drives 
that require fewer write cycles, and lower energy 
monitors. And, manufacturers of networking 
equipment are developing switches and routers 
that reduce energy costs. 
 

Recycling Materials 
 
Obsolete computers can be reused for charities, 
non-profit organizations, and developing 
countries. Parts from really old systems can be 
recycled through some recycling centers. Some 
recycling charges can be passed back to the 
manufacturers. Recycling this equipment keeps 
the lead, mercury, and chromium out of our 
landfills. In addition, computer supplies such as 
cartridges, paper, and batteries can be easily 
recycled. 
 

How Can We Work Greener? 
 
Visit the website for Climate Savers Smart 
Computing at www.climatesaverscomputing.org 

to view a three step program to go green. Here are 
the basic steps that they suggest: 
 
Step One - Turn on Power Management. Since the 
average desktop PC wastes nearly 50% of the 
energy it consumes as heat, it makes sense to use 
the power management features that are built into 
Windows XP and Vista. The benefits? You will 
reduce your electricity bills and your energy 
footprint will be lowered as you reduce your 
greenhouse gas emissions. The Climate Savers 
organization predicts that the power management 
features on your computer can save nearly have a 
ton of CO2 and more than $60 a year in energy 
costs. 
 
Step Two - Buy an energy efficient computer. 
Energy Star, the program designed by the U.S. 
Environmental Protection Agency, specifies the 
standards that equipment and appliances must 
meet to wear the Energy Star badge. You can visit 
their website at www.energystar.org for specifics. 
Basically an Energy Star compliant PC uses 15 
to 25 percent less energy. This program is 
expected to save U.S. consumers and businesses 
more than $1.8 billion in energy costs over the 
next five years and prevent greenhouse gas 
emission equal to 2.7 million vehicles. 
 
Step Three – Unplug from phantom power. As 
long as your computer is plugged in it still uses 
electricity, even while it is turned off or in standby 
mode. A computer that is turned off, but still 
plugged in, can use up to 10 watts. The Climate 
Savers estimate that you can reduce your 
electricity bills by as much as 10% by unplugging 
your appliances and electronics when they're not 
being used. 
 
This article has been provided to APCUG by the 
author solely for publication by APCUG member 
groups. All other uses require the permission of 
the author (see e-mail address above). 
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Moving On continues from page 8 

deframenter with SP1 is improved but still a 

disappointment.  

 

And that's my general impression about Vista 

SP1. I'm disappointed. The speed improvements 

that were predicted just don't seem to be there. 

Maybe the security is improved but it’s not 

obvious to me. Maybe Service Pack 2 will be 

better... 

 

This article has been provided to APCUG by the 

author solely for publication by APCUG member 

groups. All other uses require the permission of 

the author (see e-mail address above). 

 

Viewing continues from page 7 

shapes of “locators” that help the user find the 
location of the mouse pointer, and a choice of 
several lens shapes, as well as full-screen 
magnification. iZoom magnifies from 1X to 32X. 
 
The negatives I have found in iZoom are as 
follows: First, when using the lens mode, you 
have to place the lens first over what you want 
to interact with, and then move the mouse 
pointer within that lens. Second, from about the 
3X magnification up, the display becomes more 
and more pixilated which can be a problem for 
some vision conditions, such as astigmatism, 
among others. Third, there is only one voice 
offered with the speech option and it is not a 
particularly pleasant one.  
 
As you would expect, with additional options 
comes an additional cost. Again, you can 
download a 30-day demo of iZoom from the 
Website, and if you wish to purchase the 
program, the price is $199.00. However, keep in 
mind that the two major commercial screen 
magnification programs, MAGic from Freedom 
Scientific and ZoomText Plus from AI Squared, 
both weigh in at from $300.00 to $550.00, 
depending on how many options you wish to 
have. So, if you feel the need to view the bigger 

picture, give the demos of the above programs a 
try, and see if they will be of use to you. 
 
This article has been provided to APCUG by the 
author solely for publication by APCUG member 
groups. All other uses require the permission of 
the author (see e-mail address above). 
 
 

 

SIG Notes 
Digital Photography 

 

Bill Funk runs the Digital Photography SIG.  

The Digital Photography SIG meets monthly to 
discuss issues related to digital photography.  

 

If you're on the Digital Photography SIG mailing 
list, Bill will let you know where the meeting will 
be. If you're not on that list, but would like to be, 

let him know: 

Bfunk @ pippina.com 

 

Video 

David Yamamoto leads the Video SIG, which 
meets right after the Digital Photography SIG.   

 

General Interest  

Chuck  Lewis  leads the General Interest SIG.  
This SIG meets in the Fountain Hills Library 

conference room.  Email for this SIG can be sent to 
genint@phoenixpcug.org 

 

Contact SIG leaders by e-mailing 
SIGs@phoenixpcug.org for more 

information. 
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Granite Reef Senior Center  

1700 N. Granite Reef Road, 

Scottsdale  

 

 

First: ____________________________ Initial: _______ Last: ____________________________________ 

 

Address: _______________________________________________________________________________ 
 

City, State: _________________________________________________ Zip Code: ___________________ 

 

Home Phone: _______________________ Work Phone: _______________________ Ext: ____________ 
Please note:  We DO-NOT share phone numbers outside the club, and will generally only use your phone information, if we cannot contact you in timely  
fashion, via e-mail, or the club web-site 

 

Release my address to venders?     Yes   No   Note: Phone numbers will not be listed. 

 

E-mail address: ___________________________________________________________ 

May the club share your e-mail address with other members only? • Yes   No   

With club approved vendors?   Yes   No     

 Please do not share my e-mail address   
 
 

Receive Electronic newsletter ONLY 

   Yes   No 

Mail this completed form with payment to: 

 

 Phoenix PC Users Group 
 5555 N. 7th Street, Suite 5 

 PMB101 
 Phoenix, AZ 85014 

Phoenix PC Users Group Membership Application 

The Official Policy of the Phoenix PC Users Group is that we 
do not condone software piracy in any form. 
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This newsletter is a publication of the Phoenix PC 

Users Group, Inc.  All rights reserved except as 

specifically permitted. 

Articles, programs, reviews, artwork, photographs 

and any advertisements are compiled without 

verification of accuracy, or suitability to a specific 

task or computer.  Any comments, or claims, made 

within this publication are solely the responsibility 

of the author and do not express the views of any 

other group member, the Board of Directors, nor 

the Phoenix PC Users Group, Inc.  We reserve the 

right to refuse any advertising for any reason. 

The Phoenix PC Users Group News, a newsletter, is 

published monthly, with article submission 

deadlines occurring the 29th of each month.  This 

publication is mailed with the intention of reaching 

members before the monthly meeting of issue 

date.  The Group is not responsible for lost or 

destroyed newsletters, other than replacing an 

issue lost in the mail.  Notify the group Membership 

Coordinator at least four weeks in advance of 

change of address when moving. 

Copyright 2008 by the Phoenix PC Users Group, 

Inc.  This publication may not be photocopied, 

reproduced in whole or in part, by any means, 

without specific written consent of the Phoenix PC 

Users Group, Inc. 

Other computer user groups currently exchanging 

newsletters with the Phoenix PC Users Group, Inc. 

are granted permission to copy, redistribute, and 

use this publication as needed, providing that 

articles, authors and this publication are credited.  

If the author of an article is not a member of 

PPCUG the author should be contacted for 

permission. 

Submissions to the "News" should be in MS Word, 

RTF or unformatted text. 

Articles, photos, screen shots may be e-mailed over 

the Internet directly to the editor at 

jacobsbd@cox.net.  Please include the author’s 

name, address, phone number and e-mail address 

on the first lines of the article. 

All materials submitted will be considered for 

inclusion in the "News", but the Editor reserves the 

right to edit as necessary, to maintain standards of 

literacy, grammar, and length requirements.  No 

materials will be returned unless arrangements are 

made in advance. 

Did you know that you can get your newsletter  

electronically each month? 

 

Or did you expect to get a copy electronically and still  received a 

paper copy? 

 

Just send us a note or check the box on your membership  

Application.  You will get a notice each month when the newslet-

ter is available on the website.  

 

Make sure you include your email address.  At least one member 

who requested an electronic copy did not include the email ad-

dress on the membership application.   

Newsletter Policies 
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Smart Computing MagazineSmart Computing Magazine  
  

There is a way you can support your user group.  Smart Computing Magazine will give a 
gift subscription to the Phoenix PC Users Group to be used as a door prize, raffle, etc., 
for each five subscriptions received from our group.  Subscriptions can be applied for 

with the subscription coupon below or by phone as long as you use our group’s unique 
source code number (8305) when beginning the subscription. 

 
For each paid subscription using the source code 8305, our user group will be credited 

one credit. Results are calculated each quarter, and credits will accumulate until the 
group reaches five paid subscriptions, at which time they will contact the PPCUG. 

 
In the event our group does not reach the five paid subscription mark by the end of the 
quarter, credits will be carried over into the following quarter until the amount reaches 

five paid subscriptions, at which time a free subscription will be issued.  

SC: 8305 

CPU: 513 

PC Today: 197 
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East Side Meeting 
The University for Advancing 

Technologies 

 
2625 W Baseline Rd, Tempe 

South side of Baseline Rd, one 
block west of Fry’s Electronics. 

Fountain Hills 

Meeting 
Fountain Hills Library  
12901 N La Montana Dr, 
Fountain Hills 

Just west of the fountain. 

West Side Meeting 
College America Room 2 

 
6533 N Black Canyon Hwy 
Phoenix 

Turn right (east) on McLellan 
Blvd. 

 
Immediately turn right (south) 
into parking lot.. 



E-Mailing Photographs 
By Richard Kennon,  

Editor, Amador Computer Users Group, CA 

www.acug.net 

Drtrdguy(at)volcano.net 

  

Obtained from APCUG with the author's 
permission for publication by APCUG member 
groups. 
 
First, we must understand that photograph 
(image) size in the camera and in the computer is 
measured in pixels. These are the basic dots of 
color that make the picture. Do not pay any 
attention to anything that says “inches” or “pixels 
per inch.” These terms are meaningless when we 
are considering a picture either in the camera or 
in the computer. They may come into play later if 
we want to print the photo on paper. But, that is 
another subject for another time. For now, we 
think only of pixels. Most cameras record too 
many pixels to e-mail. For instance a 6 megapixel 
camera will make a picture about 3000 pixels 
wide by 2000 pixels tall and the file size may be 
several megabytes. Our screens are usually only 
about 1000 pixels wide (some are larger and 
some smaller). So, if we e-mail the native picture, 
it will be wider than the screen for the recipient 
and the file will be so large, it may take “forever” 
to download to the recipient’s computer. It is 
possible the service provider will not even accept 
it. 
 
There are two things we must do to make a photo 
e-mailable. The first is to resize or resample the 
picture. We want to change the picture width 
from 3000 pixels to 800 pixels, for instance. This 
process is called resizing or resampling. We have 
to pick the best 800 pixels out of the 3000 to 
represent our photo. Well, no, that is not exactly 
correct but it simplifies things to think of it that 
way. We don’t have to worry about it because a 
lot of very smart programmers have developed 
ways (algorithms) to help us. Just remember, you 
want to resize or resample to get the photo down 
to a size convenient for e-mailing. I usually use 

800 pixels or 900 pixels width for pictures I 
attach to e-mails. 

 
The second thing to do to make a photo e-
mailable is to save it in JPEG format (.jpg). That is 
a format that reduces file size a lot and picture 
quality a little so the picture can be downloaded 
more quickly and still be nice to look at. Some 
software programs give you choices of 
compression amount with numbers ranging from 
1 to 10. One will result in a very small file but the 
picture quality will not be good at all. A 10 will 
give the very best quality but with a very large file 
size. A reasonable compromise is to use 5 or 6. I 
usually use 6. 
 
How do you do this? First, I will describe how to 
do it with a free Microsoft program. Then I will 
try to look at some other programs. 
 
Microsoft Power Toys for XP has a Resize Pictures 
toy that is slick and easy but feedback says it only 
works on XP. It can be downloaded at http://
www.microsoft.com/windowsxp/downloads/
powertoys/xppowertoys.mspx. Right click on an 
image name or thumbnail in Explorer or My  

Photographs continues on page 11 


